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Utilizando las funciones de Email  
Reform puede enviar mensajes de correo electrónico mediante la comunicación con los 
servidores de correo electrónico. Mensajes de correo electrónico pueden contener 
texto, html o archivos adjuntos. Combinando Reform con un servidor de correo 
electrónico permite la entrega de documentos procesados por Reform a varios 
destinatarios. Mediante el envío de la información por correo electrónico, se reducen 
los costos de papel y se reducen los retrasos de entrega y respuesta. 
 

Requisitos del Sistema 
 Reform 12 Enterprise o Reform 12 PDC 

 Plugin Reform Email 

 Para la evaluación y demostración: Windows XP, Windows 2003 Server, 
Windows Vista, Windows 7 o Windows 2008 Server (Operadores de Sistema 64 Bit  son 
compatibles) 

 Para sistemas de producción: Windows 2003 Server o Windows 2008 Server 
(Operadores de Sistema 64 Bit son compatibles) 

 Microsoft .NET Framework 3.5 (se instalarán automáticamente si el instalador no 
lo encuentra en el sistema) 

 Microsoft SQL Server (SQL Server Express se instalará automáticamente por el 
programa de instalación de correo electrónico si no está presente en el sistema actual) 

 

Todas las descargas de software Reform necesarias pueden encontrarse en 
www.fabsoft.com >> Sección de descargas. 

Requisitos del Hardware 
 Recomendación de sistema de producción (estas sugerencias son sólo 

estimaciones. Entornos de alta carga pueden requerir varios servidores o hardware 
adicional.) 

1. Procesador Pentium 4 
2. 4 GB RAM 
3. HDD Space 100 GB (Redundancia recomendada) 
4. Respaldo de Batería (UPS) 
5. Servidor dedicado, no hay otros productos de software excepto 

para los programas de antivirus y seguridad. 

 Requisitos mínimos del sistema sólo con fines de demostración 
1. Procesador Pentium 4 
2. 2 GB RAM 
3. Espacio HDD 30 GB 

 

http://www.fabsoft.com/
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Especificaciones de hardware dependen enormemente de la carga de trabajo y el 
rendimiento que se requiere.  Procesadores de gama superiores y una mayor cantidad 
de memoria aumentará la cantidad de información y datos que Reform puede procesar, 
mejorando el rendimiento general del sistema.  Para equilibrio de carga y failover, 
también pueden utilizar varios servidores. (Nota: se requiere para cada servidor que 
ejecuta el software de una licencia para Reform y cada complemento.) Antes de obtener 
el servidor que desea utilizar para Reform, compruebe los manuales de usuario de los 
plug-ins para requisitos del sistema, así como pueden requerir hardware adicional. Para 
sistemas de producción, se recomiendan también discos duros redundantes utilizando 
las características de espejo de RAID (Redundant Array of Independent Disks) para 
minimizar la pérdida de datos y acelerar la recuperación del sistema en caso de una falla 
de hardware. También se sugieren respaldos de batería para mantener la disponibilidad 
del sistema y fiabilidad en caso de fallo de electricidad.     
 

Instalación 
Para instalar el plug-in de correo electrónico a su instalación existente de Reform 12, 
descargar y ejecutar el ejecutable de instalación de Email. 
 

 
 
Se iniciará el programa de instalación. No hay ninguna pre configuración necesaria para 
instalar el plug-in, así que haga click en Next y comenzará el proceso. Si no está 
instalado SQL Server Express en el sistema, se instalará automáticamente. Esto suele 
tarda entre 10 y 20 minutos entre la descarga de la aplicación y la instalación. Si 
Microsoft.NET Framework 3.5 no está instalado en el sistema, será automáticamente 
descargado e instalado. Una vez finalizada la instalación, haga click en Finish.  
 
Ahora está instalado el plug-in email. 
 
El directorio de instalación predeterminado para Reform 12 y sus plug-ins es C:\Program 
Files\Reform. Si ha cambiado la ruta durante la rutina de instalación Reform, o si utiliza 
un sistema operativo de 64 bits, consulte la ruta adecuada en lugar de la 
predeterminada uno al que hace referencia a lo largo de esta documentación. 

Registro y Licencia del Plugin 
Al evaluar Reform 12, los plugins también estarán en un modo de evaluación para ese 
período de tiempo. Una vez que Reform ha sido comprado y con licencia, se debe poner 
licencia a los plugins usados para continuar funcionando correctamente.    
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Consulte la sección "Reforma 12 licencias y registro" del Manual de Usuario Reform para 
más información acerca de cómo dar licencias a los Plug-ins de Reform 12.  Después de 
introducir la licencia, el Reform Spooler se tendrá que reiniciar para actualizar las 
licencias. Puede encontrar más información sobre el servicio Reform Spooler en el 
Manual de usuario de Reform 12. 

Tipos de Servidores Email  
El plugin de correo electrónico de Reform se integra con varios tipos de servidores de 
correo electrónico. Actualmente tiene la capacidad para comunicarse sin problemas con 
SMTP, Exchange 2003, Exchange 2007 y Exchange 2010. Al configurar el flujo de trabajo 
de Email, mediante Workflow Designer, se le dará la opción de elegir el tipo de servidor 
de correo electrónico que desea configurar. Dependiendo de qué tipo es elegido, se le 
pedirá diferentes configuraciones obligatorias y opcionales del servidor Email.  
 

Reform Email Monitor Service 
El servicio RM_Email_Monitor es instalado por la rutina de instalación Email.  Este 
servicio monitorea una tabla en la base de datos que está poblada por la secuencia de 
comandos Send To de Email para mandar emails.  Con este método, se guarda un 
registro de todos los correos electrónicos enviados. También, pueden enviar mensajes 
de correo electrónico automáticamente si no se envían al servidor de correo 
electrónico. 
 
IMPORTANTE: El Servicio RM_Email_Monitor debe privilegios de administrador locales 
para que funcione correctamente (No se puede ejecutar como Local System o Network 
Service).  Para cambiar la cuenta de inicio de sesión del servicio, ir a Start > Programs > 
Control Panel > Administrative Tools > Services.  Haga click derecho en 
RM_Email_Monitor y seleccione Propiedades. 
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Navegar a la pestaña Log On.  Aquí, debe establecer la cuenta de inicio de sesión local 
de servicio administrativo. 

 
 
Seleccione la opción “This account:”.  Y Manualmente puede introducir las credenciales 
de cuenta o utilice el botón Browse… para buscar una.  Una vez que haya introducido 
las credenciales correctas, haga clic en Aceptar para guardar los cambios. Si ya se está 
ejecutando el servicio, deberá reiniciarse deteniendo e iniciando el servicio.  Si no se ha 
iniciado el servicio, inicie el servicio después de configurar una cuenta de servicio de 
inicio de sesión administrativo. 
 

Creando su primer formulario habilitado de Email  
Creando un nuevo o ya existente formulario para conectarse a un servidor de correo 
electrónico y enviar mensajes de correo electrónico es un proceso sencillo que utiliza el 
Workflow Designer, una herramienta de creación y configuración de formularios. El 
programa de instalación permite establecer valores estáticos (sin modificar) para varios 
campos (por ejemplo, la línea de asunto, cuerpo del mensaje, destinatarios, etc.), o 
puede utilizar objetos de texto en la capa de texto para cambiar dinámicamente los 
valores.  
 
Para iniciar el tutorial, se debe abrir el Reform Designer. Para abrirlo, ir a 
Start>Programs>Reform…>Designer. 
1. Por ejemplo, crearemos un nuevo formulario con una plantilla existente. Ir a 

File>New>New. Seleccione la plantilla Email.FTM y haga click en OK. 
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2. Cuando le pregunta si desea abrir un archivo de texto para diseñar, seleccione No. 
 

3. A continuación, ir a File>Save para guardar el formulario. Nombrarlo Email.FOM. 
 
4. Usted ahora puede cerrar el Reform Designer ya que disponemos de un formulario 

que se utilizará con el diseñador de flujo de trabajo (Workflow Designer) para 

distribuir el documento. 

 

* Ahora que tenemos nuestro formulario, podemos empezar a configurar el flujo de 
trabajo de Email deseado mediante el diseñador de flujo de trabajo. En primer lugar, se 
debe iniciar el diseñador de flujo de trabajo.   
 

5. Para abrirlo, ir a Start>Programs>Reform…> Workflow Designer. 

6. Una vez abierto, debemos ir aFile > New… 

 

7. Seleccionar “Document Automation” y haga click en Ok. 
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8. Ahora verá que sus entradas, procesos y salidas han sido pobladas por los diversos 

plug-ins que  han sido instalados (Email siendo uno de las Salidas) 
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9. Ahora podremos empezar a agregar los componentes necesarios para el flujo de 

trabajo. En primer lugar, arrastrar y soltar un objeto Form and File en el flujo de 

trabajo haciendo click y manteniendo el mouse en Form and File y, a continuación, 

mover el mouse sobre el flujo de trabajo y soltar el botón del mouse.  

 
* Se le pedirá un cuadro de diálogo para describir la entrada. 

 
10. Escriba una descripción para el objeto que acaba de agregar. Para ello, escriba en el 

cuadro proporcionado. Escriba “Email Demo” y haga click en Finish. Esto le llevará 

de regreso a su flujo de trabajo. 

 

11. Ahora estamos listos para configurar el formulario “Email” y el archivo de entrada.  
Para ello, haga click derecho en el objeto recién agregado y seleccione 
“Configuration…” o simplemente haga doble click. 
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12. Ahora aparecerá la ventana Configuración de entrada. En primer lugar, queremos 
que seleccione la secuencia de datos o archivo de texto que va a utilizar nuestro 
formulario  Para ello, simplemente puede empezar a escribir en el cuadro o puede 
navegar para encontrarlo.  Queremos seleccionar el archivo Email.out que se 
encuentra en el directorio \Reform\Backups.  Haga click en el icono de carpeta 
pequeña para abrir una ventana que nos permite escoger ese archivo.  Seleccione 
el archivo y haga click en  Open.   

 

 
13. Después de seleccionar el archivo de texto, volverá a la página de configuración de 

entrada para que ahora pueda seleccionar un formulario.  Haga clic en el icono de 
carpeta pequeña para abrir una ventana que nos permite escoger el archivo de 
formulario Email.FOM deseado.  Seleccione el archivo FOM y haga click en Open.  
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14. Ahora que tiene el archivo de texto de entrada y el formulario Reform 
seleccionado, la configuración de “Form and File” está completa.  Puede 
rápidamente comprobar que los archivos correctos están seleccionados y, a 
continuación, haga click en Finish.  

 

 
15. También se le pedirá agregar un campo de salto de página a los formularios.  En 

este punto, queremos seleccionar No. 

 

16. Para terminar el flujo de trabajo de correo electrónico, queremos añadir una salida 
de Email.  Usamos el mismo procedimiento de arrastrar y colocar como con “Form 
and File” (consulte el paso 9).  Tomar el mouse y arrastre el objeto Email debajo de 
Salida hacia el flujo de trabajo en algún lugar debajo de la Entrada.  Una vez que 
suelte el mouse, se le pedirá que describa el Email.  Escriba “Email” en el cuadro y 
después haga click en Finish. 
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17. Una vez que haga click en finalizar, volverá a su flujo de trabajo. Su Email tendrá un 
título Rojo porque no se ha configurado aun. Para configurar el Email, primero 
debe conectar el  objeto “Form and File” llamado “Email Demo”.  Para ello, 
seleccione primero el botón “Add Connector” de la barra de menús.  A 
continuación, arrastre el mouse de la pequeña “x” debajo de “Email Demo” hacia 
la pequeña “x” encima de “Email” como muestra la imagen a continuación. Cuando 
se completa la conexión, el conector se volverá negro (si es roja, la conexión no se 
ha realizado correctamente, inténtelo de nuevo) y el título de “Email Demo” 
cambiará a verde. 

 
18. Deberá configurar el Email al finalizar la conexión.  Haga click en Yes.  Si hace click 

en No, también puede hacer doble click en el objeto Email o hace click derecho en 
el objeto y seleccionar “Configuration…” en un momento posterior.  Esta 
configuración le guiará a través de toda la configuración necesaria para que Email 
trabaje con su servidor de correo electrónico. La primera pieza de información es el 
tipo de archivo que desea su email adjunto que sea.  Seleccione “PDF File” y haga 
click en Next. 
 

 
 

19. Se solicitará el Email Server Type.  Usando el cuadro desplegable, puede elegir qué 
tipo de servidor de correo electrónico va a utilizar para enviar emails. Dependiendo 
del tipo seleccionado, se le dará opciones de servidor Email diferente. Para fines de 
demostración, se selecciona SMTP.  Haga click en Next cuando haya seleccionado 
el tipo de servidor de correo electrónico. 
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20. Para el ejemplo, utilizaremos los datos que ya está presentes en la corriente de 
impresión. Parte de la información que necesita para entrar se rellenará 
dinámicamente directamente de objetos asignados en la capa de texto. La siguiente 
pantalla le pedirá que introduzca la dirección de su  Email Server. Dado que es un 
valor estático, puede introducir manualmente la información de su servidor de 
correo electrónico. Haga click en Finish. 
 

 
 

21. Se solicitará ahora el Email Server Domain.  Esto es un parámetro opcional, pero se 
indicará si es necesario para su entorno. Para la demostración, se incluirla. Haga click 
en el botón Skip para continuar. 
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22. La siguiente pantalla le pedirá el Email User Name. Si su servidor de correo 
electrónico requiere autenticación, introduzca el nombre de usuario ahora y haga 
click en Next. Si no requiere autenticación, haga click en Skip. 
 

 
 

23. La siguiente pantalla le pedirá la Email Password. Una vez más, si su servidor de 
correo electrónico requiere autenticación, introduzca la contraseña aquí y haga click 
en Next. Si no lo hace, puede hacer click en Skip. 
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24. La siguiente pantalla le pedirá la dirección de correo electrónico desde la cual se 

enviará el correo electrónico. Aquí nos gustaría utilizar datos disponibles en la 
secuencia de datos en lugar de un valor estático. Para ello, primero debemos hacer 
click en el botón “Click here to select variable information”.  

 
*Nota-Después de hacerlo, vemos que aparece una lista con los diferentes campos que 
puede elegir para los datos variables. Si desea volver a modo de entrada estático, puede 
hacerlo haciendo click en el botón correspondiente para obtener información estática y 
escribiendo en el. 
 
25. Ahora queremos utilizar ContactPersonEmail como nuestro valor “Email From”.  

Seleccione ContactPersonEmail de la lista. Tendrá que desplazarse hacia abajo para 
verlo. Haga click en Next. 
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26. La siguiente pantalla le pedirá la dirección de correo electrónico a la cual se deberá 
enviar el email. Introduzca una dirección de correo electrónico que pueda 
comprobar (Ej. Su dirección de correo electrónico personal). Haga click en Next. 
 

 
 

27. A continuación, le pedirá que introduzca las direcciones de correo electrónico de 
Carbon Copies. Haga click en el botón Skip. 

 
28. A continuación, le pedirá que introduzca las direcciones de correo electrónico para 

Blind Carbon Copies. Haga click en el botón Skip. 
 
29. A continuación, le pedirá que introduzca el Return Email Address. Haga clic en el 

botón Skip. 
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30. A continuación, le solicitará el Subject del Email. Seleccione el objeto Remark. Para 

seleccionar un objeto, primero haga click en  “Click here to select variable data” y, a 
continuación, se mostrará la lista de objetos.  
Tendrá que desplazarse hacia abajo para ver Remark. Haga click en Next. 

 

 
 

31. A continuación, le pedirá el nombre de archivo del archivo adjunto. Introduzca el 
valor EmailBill. Haga click en Next. 
 

 
 

32. La última pantalla pedirá el cuerpo del mensaje de correo electrónico. Queremos 
seleccionar el objeto BillingNote.  Para seleccionar un objeto, primero haga click en 
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“Click here to select variable data” y, a continuación, se mostrará la lista de objetos. 
Seleccionar BillingNote en la lista.  Haga click en Finish. 

 

 
 

33. Se ha completado la configuración del flujo de trabajo simple de correo 
electrónico.  Los 2 objetos (“Email Demo” y “Email”) ambos deben ser verdes que 
significa que se han configurado correctamente y está listo para crear el flujo de 
trabajo. 

 
34. Para hacer todos los formularios y cambios adecuados, debemos ejecutar el flujo 

de trabajo.  Para ello, haga click en el botón “Execute”  en la barra de 
menús.   Después de la ejecución, se le notificará de la configuración que ha tenido 
lugar. Haga click en OK. 
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35. Ahora puede cerrar el Workflow Designer.  Cuando se le solicite, puede guardar el 

flujo de trabajo para que pueda volver a configurarlo en otro momento. El 
formulario se ha guardado en el directorio de formularios predeterminado.  Un 
respaldo de su archivo Email.FOM se ha copiado en la carpeta “Workflow Designer 
Original Forms” en su directorio de formularios.  Se efectuarán los cambios de 
forma permanente a su formulario original como se utiliza en todo el proceso de 
configuración del formulario como plantilla. Si las actualizaciones o cambios se 
realizan en esta plantilla, debe ejecutar el flujo de trabajo una vez más para que 
los cambios aparezcan en los formularios. 

 
36. Para probar la configuración y asegurarse de que se pueden enviar mensajes de 

correo electrónico, primero debemos abrir el formulario con el Reform Designer.  
Navegar hasta el directorio de formularios y haga doble click en Email.FOM.  Cuando 
se le pregunte abrir el archivo de texto asociado, haga click en Yes.  

 
37. Compruebe que los campos especiales existen en la parte derecha del formulario. 

Vaya a File>Print. Reform utilizará la información sobre los objetos que se acaba de 
agregar al formulario para procesar y enviar el correo electrónico. 
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El correo electrónico deberá enviarse a cualquier dirección que ingreso para el EmailTo 
durante la configuración con el Workflow Designer. El tiempo que tarda el correo 
electrónico para enviar variará en función de la velocidad y la carga de trabajo del 
servidor de Email que utiliza. Si no recibe un correo electrónico después de un minuto o 
dos, compruebe que el servicio  RM_Email_Monitor se está ejecutando y tiene la cuenta 
de inicio de sesión.  Para obtener más información sobre el servicio, consulte la sección 
Servicio Reform Email Monitor. Si el servicio se está ejecutando y todavía no está 
recibiendo mensajes de correo electrónico, consulte la sección Solución de Problemas 
de este manual.  Con esto concluye la configuración básica y el envío de un correo 
electrónico. Para experimentar con opciones más avanzadas, como copias y copias 
ciegas, leer la siguiente sección para obtener información sobre diferentes campos y 
cómo puede trabajar con ellos para realizar operaciones más avanzadas de correo 
electrónico. 
 

Descripción de campos del Asistente de Configuración 
Puede ejecutar el Asistente de configuración yendo a File>Page Setup, y, a continuación, 
pulsando el botón Setup en la parte inferior de la ventana bajo Send To Devices.  
También puede acceder a esta configuración mediante el Workflow Designer para 
volver a configurar los objetos que acaba de agregar. 

 Email Server – Este es el nombre o la dirección IP del servidor de correo 
electrónico de la cual se enviarán mensajes de correo electrónico. 

 Email User Name – Si su servidor de correo electrónico requiere autenticación, 
aquí aparece el nombre de usuario para la autenticación. 

 Email User Password – Si el servidor de correo electrónico requiere 
autenticación, aquí se introduce la contraseña para la autenticación. 

 Email From – Cuando un usuario recibe un correo electrónico, esto es de quien 
fue enviado el email. 

 Email To – La dirección de correo electrónico de la cual se enviará el correo 
electrónico. Si especifica varias direcciones de correo electrónico, sepárelas con comas. 
Por ejemplo: user1@fabsoft.com, user2@fabsoft.com, user3@fabsoft.com.  

 Email CC – En este campo, se pueden introducir una o varias direcciones de 
correo electrónico para que el correo electrónico sea “carbon-copied” a direcciones de 
correo electrónico diferentes. 

 Email BCC – Misma funcionalidad como correo electrónico CC, excepto esto será 
una “carbon copy” a ciegas a todos los usuarios de la lista. Separar varias direcciones de 
correo electrónico con una coma. 

 Return Email – Específica la dirección de retorno cuando un usuario responde a 
un correo electrónico que recibieron del plug-in Reform Email.  

 Subject – Especifica al asunto del correo que se enviará por el Plug-in Email. 

 File Name – Establece el nombre del archivo adjunto de correo electrónico. 

 Notes – El cuerpo del mensaje de correo electrónico. 
 

mailto:user1@fabsoft.com
mailto:user2@fabsoft.com
mailto:user3@fabsoft.com
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Descripciones de campos de Diseño de Email 
La siguiente es una lista de campos disponibles de correo electrónico. Estos campos se 
encuentran en el menú de campos especiales. 
 

1. EmailTo: Este campo se utiliza para capturar la dirección de correo 
electrónico del destinatario. Puede utilizarse en la capa de texto o en la capa 
de diseño. Cuando se utiliza en la capa de texto, utilizará la dirección de 
correo electrónico que destaca de este objeto. Cuando se utiliza en la capa 
de diseño, puede proporcionar una dirección de correo electrónico estático 
o, utilice la opción de búsqueda de la empresa para ocupar la dirección de 
correo electrónico. Consulte el Manual de reforma para obtener más 
información.  

 
Objeto EmailTo de la capa de texto  

 
(Objetos EmailTo de la capa de diseño aparecerán como campos con texto 

rojo) 
 

2. EmailFrom: Este campo se utiliza para proporcionar la dirección de correo 
electrónico de un remitente concreto. Este objeto se puede utilizar el texto y 
las capas de diseñador. 

3. Subject: Este campo se utiliza para suministrar un tema para el correo 
electrónico 

4. Notes: Este campo se utiliza para incluir toda la información que desea 
agregar al cuerpo del correo electrónico 

5. Company Lookup: Este campo se utiliza para encontrar una dirección de 
correo electrónico y otra información en la base de datos de búsqueda. Este 
campo se puede utilizar en el texto o la capa de diseño. Si el campo de 
EmailTo está vacío, Reform utilizará la base de datos de búsqueda para 
encontrar la dirección de correo electrónico. Si desea usar sólo la base de 
datos de búsqueda, colocar el campo de EmailTo en la capa de diseño y 
eliminar la información de texto en el objeto. 

 
Campos específicos del sistema: Algunos sistemas tienen campos que se deben agregar 
manualmente. Para agregar manualmente los campos, agregar un objeto de texto de 
diseño/vinculado a la capa adecuada y cambiar el nombre del objeto de texto 
respectivamente. Para obtener más información sobre el ámbito específico del sistema, 
consulte Sección del sistema de correo electrónico. 
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Mantenimiento 
Hay ciertos directorios y tablas SQL que deben controlarse para crecimiento, junto con 
el plugin Email para Reform 12.  Cada vez que un sistema procesa más y más empleos, el 
tamaño de estos directorios y tablas SQL puede crecer muy rápidamente. En general el 
rendimiento del sistema puede verse afectado por la gran cantidad de espacio que 
pueden ocupar los archivos.  Además, existe un límite de base de datos de 4 GB si utiliza 
Microsoft SQL Server Express 2005 suministrado con la instalación. Entradas obsoletas 
archivos/base de datos se deben eliminar de acuerdo a sus necesidades y 
especificaciones de retención de archivos. Se recomienda monitorear el crecimiento de 
los siguientes directorios y tablas SQL: 
 
Directorios: 
C:\Program Files\Reform…\Backups 
C:\Program Files\Reform…\Spooler\ImageQueue 
C:\Program Files\Reform…\Plugins\Email \Attachments 
 
Tablas SQL: 
Reform_Email_Status 
Reform_Email_Trans 
 

Solución de Problemas 
Q: El servidor SMTP no se puede alcanzado. 
A: Lo primero que debe hacer si no recibe los mensajes de correo electrónico es probar 
para ver si el servidor SMTP funciona correctamente y se puede llegar desde el servidor 
Reform. Telnet, el cual no está instalado de forma predeterminada en todos los 
sistemas, puede utilizarse para comprobar la conectividad. Si está instalado, ir a, 
Start>Run, ingresar cmd, y presionar OK. En el comando, escribir: 
 

telnet <your smtp server here> 25 
Ejemplo: telnet mail.yourcompany.com 25 

 
y presione Enter. Debería ver un mensaje de conexión establecida en la línea de 
comandos, similar a la siguiente: 
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Si no puede conectarse a su servidor SMTP en el puerto 25 (el puerto SMTP 
predeterminado), entonces el servidor no es accesible desde el servidor de Reform, y 
como tal, no será capaz de enviar el correo electrónico. 
 
Q: El servidor SMTP esta rechazando mi nombre de usuario y contraseña de 
autenticación. 
A: Asegúrese de que ha introducido el nombre de usuario y la contraseña 
correctamente en el Asistente de configuración. Para ello, abra el formulario en el 
diseñador, ir a File>Page Setup, y haga click en el botón Setup en Send-To Devices. Siga 
paso a paso a través de las instrucciones del Asistente para la instalación y verificación 
para asegurarse de que los valores son correctos para la autenticación. 
 
Q: Dónde puedo ver la interfaz de webmail de Exchange 2003? 
A: El URL es http://<EMAILSERVERNAME>/Exchange/.  Esto le pedirá un nombre de 
usuario y una contraseña. También puede intentar 
http://<EMAILSERVERNAME>/Exchange/<USERNAME or USERALIAS>/ 
 
Q: No pasa nada después de que el formulario es procesado. Cómo puedo determinar la 
causa de un problema? 
A: Comprobar el registro de eventos para errores relacionados con Reform o el Servicio 
Reform Email.  Se puede tener acceso al El registro de eventos al ir a Control Panel > 
Administrative Tools > Event Log.   Esto generalmente le dará una buena idea acerca de 
por qué pueden estar fallando los mensajes de correo electrónico.   
 
Nota: Si se produce el siguiente error, ir a Control Panel > Administrative Tools > 
Services y pruebe con otra cuenta para ejecutar ReformEmailService, como la cuenta de 
administrador local de windows. Para cambiar la información de inicio de sesión, haga 
click derecho en ReformEmailService>Properties>Pestaña Log On y escriba la cuenta que 
desea utilizar. Haga click en Ok y reinicie el servicio. 

 
 

Q: No se reciben los mensajes de correo electrónico; no requiere autenticación en mi 
servidor SMTP. 
A: Compruebe la configuración de retransmisión del servidor SMTP para asegurarse que 
el servidor Reform tiene los permisos adecuados. También asegúrese de que cualquier 
software de fuego/anti-virus esté desactivado. 


